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Running SPSS

Chapter Purpose

This chapter introduces fundamental concepts of data entry and running
SPSS.

Chapter Goal

To provide readers an opportunity to enter data, run SPSS, and review results.

Chapter Glossary

Chart Editor: SPSS window in which charts can be edited.

Data Editor: SPSS window in which data can be entered and defined.

Designated Window: If multiple windows of one type are opened (e.g.,
Viewer windows), the one which is active and in which work can be done.

SPSS-Format Data File: A data file saved by SPSS with both data and file
definitions.

String: A variable that can have either numbers or letters for values.

Syntax Editor: SPSS window in which command syntax can be written and
edited.

Syntax File: File containing SPSS command syntax.

Viewer: SPSS window in which output is displayed.
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N ow for the fun for which we have been waiting. First, we will take
a look at the way SPSS runs and some of the files that it uses.

Next, we will create a dataset using the Wintergreen data. Once the data
have been entered, we will use the SPSS pull-down menus to conduct
the first analyses of these data. We will then use SPSS to draw a chart
displaying the results of one of the analyses. By the end of the chapter,
you will have taken the first steps to becoming a proficient SPSS user,
and the groundwork will have been prepared to support further investi-
gation into intermediate SPSS topics. Remember, the information that
is covered will be easier to understand if you practice at your computer
at the same time that you read this book.

You can run SPSS using either the pull-down menus or the Syntax
Editor. The former method is a menu-driven approach, while the latter
method involves writing your own SPSS programs. We will begin by
using the pull-down menus to run SPSS. The use of the syntax window
to run SPSS will be deferred until Chapter 7.

SPSS FILES

SPSS uses several types of files. First, there is the file that contains the
data that have been entered using the SPSS Data Editor window. This is
called, simply enough, the data file. Since this file has been saved using
SPSS, it is known as an SPSS-format data file, and it contains both the
data and all the related file definitions (for example, the columns the
variables are in, the variable and value labels, and the codes that have
been used to define missing values). In contrast, a data file that has been
created with your favorite word processor and saved in text format is
known as a raw data file, and SPSS has to be told how the file has been
defined in order to be able to read it.

Once SPSS has conducted an analysis, it displays the results in the
output “Viewer” window. The important thing to remember is that
you create the data file and instruct SPSS what analysis to perform.
SPSS then conducts the analysis and displays the results. These con-
tents of this window can be saved in a viewer file. SPSS also creates a
journal file that records the commands run during an SPSS session
(this file is not automatically displayed, and we will not be concerned
about it at this time).

An Introductory Guide to SPSS® for Windows®
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You have the freedom to call your files whatever you wish, within
the restrictions posed by the computer’s operating system. Files have a
filename followed by a three-character extension (readers unfamiliar
with Windows will benefit from a review of any book that discusses
file names and directory structure). SPSS has the default convention
of naming data files with a .sav extension and Viewer files with a
.spo extension. It is helpful to use the same name for files related to
one program and to vary the file extensions to identify the different
types of files. For example, in the Wintergreen study, it would make
a great deal of sense to name the two files:

Data file: wintergreen.sav
Viewer document: wintergreen.spo

Notice how this approach allows you to keep all the related files in
one group, but to easily distinguish each one. Later, if you created an
SPSS syntax file to analyze these data, then that file could be named
using the default .sps extension:

Syntax file: wintergreen.sps

Similarly, if the Wintergreen data were first entered into an external
raw data file (to be read by SPSS at a later time), then that file could be
named:

External data file: wintergreen.txt

GETTING STARTED: ENTERING THE WINTERGREEN DATA

Let’s get started! Launch SPSS from the Windows Start Button (that
is, click the Start Button, select Programs, and select SPSS 12.0
for Windows). At the top of your screen, you will see the pull-
down menus, and just below them, you will see a toolbar with several
icons. If you place the mouse pointer on any one of the toolbar

15Running SPSS
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icons, SPSS will display a label telling you what that icon does. SPSS
automatically opens the Data Editor window, and your screen looks
like Figure 3.1.

An Introductory Guide to SPSS® for Windows®

Figure 3.1 SPSS Data Editor Window: Data View

Notice that the Data Editor window looks much like a spreadsheet, in
that it is made up of cells defined by both rows and columns (here is
where the resemblance ends, however, as the Data Editor is not capable
of spreadsheet functions). In the Data Editor window, each row always
represents a single record, and each column always represents a single
variable. By using the keyboard arrow keys (up, down, right, and left) or
your mouse, you can move the cursor around to different cells in the
window.

Notice that at this point, each column of data has automatically
been called “VAR” by SPSS. Once data have been entered, the first
column will be called “VAR00001,” the second will be called
“VAR00002,” and so on. However this is not very informative, so it
is helpful to give the variables more descriptive names. In addition,
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since it is easier to work with variables if they have short names (and
in earlier versions, the variable name was limited to eight characters
in length), it too may be less descriptive than we would like, so we
will assign a label to the variable name. We will want to assign labels to
coded values for the same reason. This idea of labeling the variables
and their values is an important one, as it will make data entry easier
if you apply the labels before entering the data. In addition, your SPSS
output will be much easier to read if the variables and values have been
labeled.

To label the first variable, click on the “Variable View” tab at the
bottom of the screen, so that your screen now looks like Figure 3.2.

17Running SPSS

To label the first variable, place the cursor on the upper-left-hand
cell and enter the variable name. Since we will be entering the data
from the Wintergreen study, enter “RespondentNumber” in this cell
(remember, SPSS does not allow a space in the variable name, so that

Figure 3.2 SPSS Data Editor Window: Variable View
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18 An Introductory Guide to SPSS® for Windows®

“Respondent Number” would not be accepted as a variable name).
Now, press the enter key and notice that SPSS prompts you for addi-
tional information about the variable by presenting the screen shown
in Figure 3.3.

Figure 3.3 SPSS Data Editor Window With First Variable Named

Use your mouse to click on the cell on the same row that is in the
“Label” column and enter “Respondent Number” as the variable name.
Notice that when you click the “Data View” tab at the bottom of the
screen, the first variable is now labeled “RespondentNumber” rather
than “VAR.”

Now, on the second line, enter “aa” as the variable name for the
second variable and “Academic Ability” as the variable name. At this
point, notice that you have other options available to you in Variable
View screen. For example, if you click on the ellipsis (“. . .”) in the Type
cell, you will be presented with the dialog box shown in Figure 3.4 and
several different data types to choose from.
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By default, the variable is considered to be a number that has up to
eight digits. You can tell SPSS to expect a larger number by entering a
different size in the Width and Decimal Places boxes, although that
is certainly not necessary for the Wintergreen data. It is important to
notice, though, that this is where you can tell SPSS to expect a “String”
variable (that is, an alphanumeric variable that can be coded with
either numbers or letters) if appropriate. For example, if for the
“Gender” variable, we had used “M” instead of “0” for “Male” (and “F”
instead of “1” for “Female”), then the Data Editor would not let you
enter these values until you told it to expect “Gender” as a “String”
variable. You may also choose from several other variable types, as
appropriate for your data.

Now, on the third line, enter “pe” as the variable name for the third
variable and “Parent Education” as the variable name, and enter “sm”
as the variable name for the fourth variable and “Student Motivation”
as the variable name. Click on the cell in the fourth row under in the
column labeled “Values” and then click on the ellipsis that appears
in this cell. You will then see the Value Labels dialog box shown in
Figure 3.5.

Use the tab key (or the mouse) to bring the cursor to the Value box in
the Value Labels section. Enter a “0” (which is our first value), then tab
or click down to the Value Labels box and enter “Not willing,” and,
finally, click the Add button. Repeat for the other two values of this vari-
able (refer to the codebook in Figure 2.1 for the values). The Value Labels
dialog box will now look like Figure 3.6.

Figure 3.4 Variable Type Dialog Box
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20 An Introductory Guide to SPSS® for Windows®

Once you have finished assigning value labels for the student motiva-
tion variable, click the OK button to return to the Data Editor window.
If you discover later on that for some reason, you need to further define
this variable (for example, if you want to change the labels), you can
always return to this dialog box. As their names suggest, the Change
button can be used to change a value label, the Remove button can be
used to remove a value label, the Cancel button can be used to cancel
your labeling work, and the Help button can be used to access the SPSS
help file.

Another important option that is available to you in the “Variable
View” screen is that of declaring the placeholders that have been

Figure 3.6 Value Labels Dialog Box With Labels Entered

Figure 3.5 Value Labels Dialog Box
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used for missing values. For example, remember that “Student
Motivation” may take only the values of “0,” “1,” and “2.” Earlier, I
suggested that if the measure of student motivation was not avail-
able for a respondent, then an out-of-range value such as “9” could
be used to indicate that this respondent had missing data. If this has
been done, it will be necessary to declare “9” as a missing value by
clicking on the ellipsis in the Missing Values cell, selecting
Discrete Missing Values in the Missing Values dialog box that
appears, entering “9” as the missing value, and clicking the OK but-
ton. If, in this case, “9” is not declared as a missing value, then it will
be considered to be a non-missing value and treated as such in the
data analysis (this, of course, would lead to incorrect results). The
Missing Values dialog box now looks like Figure 3.7.

Figure 3.7 Missing Values Dialog Box With Discrete Value Entered

Now go ahead and assign the variable and value labels to the remain-
ing variables (see the codebook in Figure 2.1 for the labels).

To enter the data for the Wintergreen study, return to the Data View
screen (by clicking the Data View tab at the bottom of the screen) and
move the cursor to the upper-left-hand corner of the screen. Enter “1”
for the first respondent number, then move the cursor one cell to the
right and enter “93” for the academic ability score, then move the
cursor one cell to the right and enter “19” for parent education, and
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Go ahead and enter the first 10 records (see Table 2.2 for the data).
Now save the data. This can be done in one of two ways. The first
method is to use the File pull-down menu and the Save choice. Since
these data have not previously been saved, you will see a dialog box
prompting you to enter a file name. Notice that SPSS provided the
default data file extension (.sav). Type in the name “wintergreen” and
click the Save button. SPSS will then save the data to this file (SPSS will
automatically attach the .sav file extension if you do not type it in—in
general, SPSS will automatically attach the default file extension if you
do not type it in (e.g., .sav for a data file, .spo for an SPSS Viewer file, .sps
for a syntax file, etc.). As an alternative to using the pull-down menu,
you could click on the Save File icon in the toolbar (it is the second icon
from the left and looks like a diskette). One other alternative would be to
select File Save As . . . if the dataset had already been saved once but
you now want to save it as new file with a new name.

22

so on. Once all the data for that record are entered, move the cursor
to the left-most cell in the second line. You are now ready to enter the
second record, and the Data Editor window looks like Figure 3.8.

An Introductory Guide to SPSS® for Windows®

Figure 3.8 Data Editor Window With First Case Entered
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Go ahead and enter the rest of the Wintergreen data. As a precaution,
save your data each time you have entered another 10 records. Once all
the data are entered, it is also a good idea to copy the dataset to a diskette
(or some other storage device such as a CD or thumb drive) as a backup
procedure. Making a backup copy of your work takes far less time than
would be required to reenter the data should they accidentally be deleted
from your computer.

DATA ANALYSIS

Now you are ready to conduct data analysis with SPSS. First, let’s
answer the question, “What are the smallest, largest, and average
values for Academic Ability and Parent Education?” From the Analyze
pull-down menu, select Descriptive Statistics, then Descriptives . . .
You will be presented with the dialog box shown in Figure 3.9.

23Running SPSS

Figure 3.9 Descriptives Dialog Box

This dialog box is typical of what you will see for each of the different
analyses SPSS is capable of performing. Click the variable “aa” to select
it for analysis, and then click the button with the picture of the right
arrow. This will move the variable “aa” from the list of all available vari-
ables on the left to the list of selected variables on the right. Now click
the variable “pe” in the list on the left, and then click the button with the
picture of the right arrow. Next, click the Options button to see the
“Descriptives: Options” dialog box and make sure that there is a “�”
in the boxes for the mean, standard deviation, minimum, and maximum
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(if a box is empty, then click on it to select it; similarly, if a box is marked,
then click on it to deselect it). Then click the Continue button.

Now you can select one of the buttons on the right of the Descriptives
dialog box. If you select OK, the analysis will be performed. If you select
Paste, the SPSS code for this analysis will be written to the syntax window.
This is a very important point that we will return to in Chapter 7. If you
click Reset, the variables you have selected for analysis will be returned
to the list of variables on the left (that is, all the available variables will
be listed, and none will be selected for analysis). If you select Cancel, no
analysis will be done and you will return to the window you were in before
you chose the Analyze pull-down menu (e.g., the Data Editor window).
Finally, if you choose Help, you will access the SPSS help facility.

At this point, click the OK button and run the analysis. SPSS will
switch to the SPSS Viewer window and perform the analysis. You will
see the following results in this window as shown in Figure 3.10.

An Introductory Guide to SPSS® for Windows®

Figure 3.10 Viewer Window With Results From Descriptives Procedure

Congratulations! You are now a beginning SPSS user, and you have
just completed a data analysis task using SPSS. Wasn’t that considerably
easier than performing these analyses by hand? Image the increased rel-
ative ease if you had 500, 5,000, or 500,000 cases instead of just 50.
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Let’s take a careful look at the SPSS Viewer window. First, note that
the window is divided into two panes. The pane on the left shows the
contents of the SPSS output in outline form. In our present example,
the first level of the outline is called “Output.” Following the Output
is the “Log,” which contains the commands that SPSS executed to run
the analysis. Don’t worry if you do not see the log in your output, as
that simply means that the option to display the log in the SPSS Viewer
has not been selected for your program (however, you may change that
option if you wish). Next is the heading for the results of our first analy-
sis, which is labeled “Descriptives.” Within the descriptive analysis is a
“Title,” “Notes (which have been hidden),” and the “Descriptive
Statistics” themselves. The contents of any level of this outline can be
displayed or hidden by using the Show and Hide toolbar icons (the fifth
and sixth icons on the second row of the toolbars) or by double-clicking
on the symbol on that level of the outline.

The pane on the right provides the detailed results of the SPSS analy-
sis. By clicking on any line of the outline on the left, the corresponding
detail appears on the right. For example, if you click on “Titles” in the
outline on the left, an arrow points to the title line on the right. This
is the title that SPSS has provided to the output from the descriptive
statistics analysis. You can edit the title by double-clicking on it and
then making the changes you wish to the title. If you then click on
“Descriptive Statistics” in the outline on the left, an arrow points to table
on the right, which contains the results of the analysis. Thus, by using
the outline on the left, you can easily navigate through the output to see
the portion in which you are interested. This is particularly helpful
when the output is lengthy, in that it is easy to go directly to any portion
of the output without having to scroll through the entire output search-
ing for the portion that you want.

Now let’s take a look at the results of the analysis. In the first column
of the results, SPSS informs us which variables have been analyzed.
In the next column, we see the number of cases that were used in
the analysis (since there were no missing data for either variable, all
50 cases have been used in the analyses). Next, we see the minimum
and maximum values of the variables (for example, the fewest number
of years of parent education is 9, while the most is 20). We then see the
means and standard deviations for each variable (the mean number of
years for parent education was 13.82, with a standard deviation of
2.74). The last line of the output shows the “Valid N (listwise).” This is
the number of valid cases (i.e., cases with no missing data). By default,

25Running SPSS
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“Descriptive” will include the total number of valid cases available for
any one variable. For example, if there had been no missing cases for the
academic ability variable and one missing case for the parent education
variable, then 50 cases would have been included in the first analysis,
49 cases would have been included in the second analysis, and 49 cases
would have been counted in the “Valid N (listwise).”

It is worth noting that had we not taken the time to assign names
and labels to the variables, then instead of seeing “Academic Ability”
and “Parent Education” in the left column, we would instead see
“aa” and “pe” or “VAR00002” and “VAR00003” (that is, either the
variable name without a label or the default name for the variables in
the second and third columns of the Data Editor window if they are
not given a name). This might be okay for this first analysis, but if you
do several analyses with different data and different variables and you
do not name and label your variables, you will soon be looking at
several different outputs, all with the default variable names. Clearly,
this would quickly become confusing. In addition, you may wish
to show this output to someone who is not familiar with the study or
the dataset, and it is helpful for them to be presented with variable
labels. In short, make it easy on yourself and others by using variable
and value labels.

Go ahead and save the output. From the File pull-down menu, select
Save. Give the output file a name such as “Wintergreen.spo” (since this
is the output from the first analysis of the Wintergreen data), and click
the Save button. Notice that you can use standard Windows procedures
to select the drive or directory in which to save the file (readers unfa-
miliar with Windows procedures will benefit from a review of any book
in which they are covered).

If you wish to switch between the Data Editor window and the
Viewer window, you may do so by choosing from the open windows,
which are listed in the Window pull-down menu. Alternatively, you
can click on the buttons on the Windows task bar at the bottom of your
screen. In general, you can use either of these techniques to switch
among any of the windows that are currently open.

Now let’s obtain frequency distributions to answer the question,
“What are the demographic characteristics of the students in the
Wintergreen study, how motivated were they, and how likely to succeed
in college were they rated?” From the Analyze pull-down menu, select
Descriptive Statistics, and then select Frequencies . . . You will see
the dialog box Shown in Figure 3.11.

An Introductory Guide to SPSS® for Windows®
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Click on “sm” in the list of variables available for analysis on the
left. Then click the button with the picture of the right-hand arrow.
The selected variable will be moved to the list on the right. Repeat
this procedure to select the variables “ae,” “r,” “g,” and “c.” If you
wish, you could also select “aa” or “pe,” but this is not a particularly
meaningful way to summarize the data for those variables. Similarly,
you could also select “RespondentNumber,” but you already know
that you will get a list of values from 1 to 50, each with one case
(if you do not see what I mean, I encourage you to select
“RespondentNumber” to include in this analysis, and then study the
output). You will notice that you have several options available in this
dialog box, but we will not select any of them at this time. Go ahead
and click the OK button. Once SPSS has completed the analysis, the
results appear in the Viewer window.

First, note that on the left-hand side of the window, the outline for the
results of the Frequencies analysis has been added below the outline for
the Descriptives analysis (of course, if you opened and designated a new
Viewer window, or if you ended your SPSS session after the Descriptives
analysis and started a new session before conducting the Frequencies
analysis, then the contents of the Viewer window would contain only
the results of the Frequencies analysis). Reading down this outline, you
first see “Frequencies” as a second-level heading in the outline, and
beneath this heading are headings for the “Title,” “Notes,” “Statistics,”
and then the “Frequency Tables” as a third-level heading, which

Figure 3.11 Frequencies Dialog Box

03-Einspruch (SPSS).qxd  11/18/2004  8:21 PM  Page 27



28

includes as a fourth-level heading the results for “Student Motivation,”
“Advisor Evaluation,” “Religious Affiliation,” “Gender,” and “Commu-
nity Type.” By clicking on any one of these fourth-level headings in
the outline, you see the corresponding results of the analysis in the
right-hand side of the window.

You will see that the default title SPSS has provided for this set of
analyses is simply the word “Frequencies.” Again, you may double-click
on the title to edit it if you wish. The “Statistics” table details the number
of valid and missing cases for each variable that has been included in
the analysis.

In the left-hand pane of the window, click on “Student Motivation”
to see the results for the frequencies analysis for that variable as shown
in Figure 3.12.

An Introductory Guide to SPSS® for Windows®

Figure 3.12 Partial Results From Frequencies Procedure

sm Student Motivation

Valid Cumulative
Frequency Percent Percent Percent

Valid .00 Not willing 13 26.0 26.0 26.0

1.00 Undecided 23 46.0 46.0 72.0

2.00 Willing 14 28.0 28.0 100.0

Total 50 100.0 100.0

These results include the frequency of cases that responded with
each value of the variable, followed by the percentage of cases, the
valid percentage of cases, and the cumulative percentage of cases.
Thus, in the “Frequency” column, we see that 13 students indicated
that they were “Not willing” to spend extra hours studying, 23
students were “Undecided,” and 14 students were “Willing” to spend
extra hours studying. Next, there are three columns of percentages.
The “Percent” column is the percentage of students in each category,
based on the total number of cases. If there were cases with missing
data, then there would be a fourth row for this variable (labeled
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“Missing”) and the percentage of cases in the “Missing” category
would also be calculated. The next column, labeled “Valid Percent,”
shows the percentage of cases in each category based on the number
of cases with non-missing data. For example, if two cases had missing
data, then these two cases would be excluded from the analysis and
the percentage in each category of student motivation would be based
on 48 cases. Because no cases in this example have missing data, the
two columns (“Percent” and “Valid Percent”) show identical results.
The fourth column shows the cumulative percentage for the fre-
quency distribution.

The rest of the output is similar in format and shows the results for
the other variables. You should see that 26% of the students were
evaluated as “Likely to fail” in college, 50% were evaluated as “Could
succeed or could fail,” and 24% were evaluated as “Likely to suc-
ceed.” Among the students, 42% indicated that they were Catholic,
40% indicated that they were Protestant, and 18% indicated that
they were Jewish. In terms of gender, 56% of the students were male,
and 44% were female. Finally, 60% of the students came from an
urban community, while 40% came from a rural community.

DRAWING CHARTS

You can draw charts using the SPSS chart feature. Charts are very
important for displaying data, whether for the purpose of examining
the data or for the purpose of communicating the results of an analy-
sis. To draw a chart, simply select this option (if it is available) when
conducting an analysis. Let’s look at an example. First, return to the
Frequencies dialog box, select only the variable “sm” (you can deselect
variables by clicking on them and then clicking the button with the
left-hand arrow on it), and then click on the Charts . . . button. You
will see the dialog box shown in Figure 3.13.

Select Bar Chart as the chart type and Percentages as the chart
values. Then click the Continue button to return to the previous dialog
box. Finally, click the OK button to run the analysis. SPSS first creates
the frequency distribution and then draws the chart. You can see the
chart by clicking on “Bar Chart” in the outline on the left-hand side of
the Viewer window. It should look something like Figure 3.14 (depend-
ing on how your Preferences are set).

29Running SPSS
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Figure 3.13 Frequencies Chart Dialog Box
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Figure 3.14 Chart Drawn With Default Specifications

Double-click the chart to enter the “Chart Editor” window. There are
many things you can do with your chart once you are in this window.
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For example, I would like to change the scale of the Y-axis so that the
percentages are displayed in a range from 0 to 100 (I encourage you to
display the full range whenever you are using percentages as an axis
scale unless you have a particular reason to do otherwise). From the
Edit pull-down menu, choose Select Y Axis, and then click the Scale
tab in the properties dialog box. Click the box for the “Maximum” under
the “Auto” column so that it does not have a check mark in it, and then
change the “50” to “100” in the box under the “Custom” column. The
dialog box will now look Figure 3.15.

31Running SPSS

Figure 3.15 Chart Properties Dialog Box
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Now click the Apply button, and notice that the chart has been rescaled.
If you wish to apply similar formatting to other charts, then you can

save these changes as a chart template. To do so, in the Chart Editor
window, from the File pull-down menu, select Save Chart Template.
You will then be asked to specify the features of the template you wish
to save, and then after clicking the Continue button, you will be asked
to specify a name and location for the template to be saved. You can then
apply this template to charts that you draw at a later time. To see how
this works, save the chart template as “MyFrequencies” (SPSS gives
the chart template the default extension of .sgt), run the Frequencies
procedure for another variable (for example, “Community Type”) and
then double-click the chart to open the Chart Editor window. Next, from
the File pull-down menu, select Apply Chart Template . . . select
the template named “MyFrequencies.sgt,” and click the Open button
to apply to template to the new chart.

Now close the Chart Editor window and return to the Viewer window.

DESIGNATING A WINDOW

SPSS allows you to have more than one output window open at a time.
To open a second (or third, or fourth, etc.) window, from the File pull-
down menu, select New, and then Output. Since SPSS can work with
only one active data file at a time, if you choose File, New, Data, it will
want to close the current data file and open a new one.

Although you can have more than one Viewer window open at a time,
only one of them can be designated. In other words, you may have more
than one Viewer window open at a time, but when you click the OK but-
ton from a dialog box, SPSS can display only the results of an analysis in
one of the open Viewer windows. How does SPSS know which one to
use? It uses the one that has been designated. You can tell which window
has been designated by looking at the center of the bottom of the screen.
If there is a red exclamation point there, then the window has been des-
ignated. If no exclamation point appears at the bottom of the window,
then that window has not been designated. To change which window is
designated, simply click the icon with the exclamation point that appears
at the right end of the upper toolbar in the Viewer window.

Having more than one window open affords you options that
you otherwise would not have. As a simple example, consider the two
analyses we have done so far. You may want the results of the analysis of
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the academic ability and parent education data to be saved in one Viewer
file and the results of the frequency distributions of the other variables to
be saved in a different file. In this case, you would send the results to two
different Viewer windows by designating the first window and running
the first analysis, and then designating the second window and running
the second analysis. You could then save the results in two different files.
The more you use SPSS, the more you will encounter different scenarios
and reasons for which you will wish to exercise the option of using
different output windows. (Note: The concept of having multiple open
windows and changing which one is designated also applies to syntax
windows, which are discussed in Chapter 7.)

33Running SPSS

EXERCISE ONE

At the end of a semester-long course, a teacher decides to
obtain students’ feedback regarding their perceptions of the
course through the administration of an anonymous survey.
The fourth item on the survey states, “I liked the text that was
used in this course,” and students are asked whether or not
they “Agree,” are “Undecided,” or “Disagree” with this state-
ment. All 10 students complete the survey, and the following
hypothetical data are collected:

Student

Number Item_04

01 Agree
02 Agree
03 Undecided
04 Agree
05 Agree
06 Undecided
07 Agree
08 Agree
09 Agree
10 Agree

(Continued)
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Use SPSS to analyze these data to answer the question, “Did
students in the course like the text that was used?” You will need
to create a codebook, code the data (use “1” to indicate “Agree,”
“2” to indicate “Undecided,” and “3” to indicate “Disagree”), enter
the data, assign variable names and labels, assign value labels,
generate a frequency distribution for this item, and state the
answer to the research question.
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